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Products taken into account 

Product Name Model Part number 

PCAN-PC/104 Single Channel One CAN channel IPEH-002054 

PCAN-PC/104 Dual Channel Two CAN channels IPEH-002055 

PCAN-PC/104 Single Channel 
opto-decoupled 

One CAN channel, galvanic 
isolation for CAN connection 

IPEH-002056 

PCAN-PC/104 Dual Channel 
opto-decoupled 

Two CAN channels, galvanic 
isolation for CAN connections 

IPEH-002057 

 

The cover picture shows the product PCAN-PC/104 Dual Channel opto-decoupled. 
Other product models have an identical form factor but vary in equipment. 

CANopen® and CiA® are registered community trade marks of CAN in Automation 
e.V. 

All other product names mentioned in this document may be the trademarks or 
registered trademarks of their respective companies. They are not explicitly marked 
by “™” and “®”. 

© 2012 PEAK-System Technik GmbH 

PEAK-System Technik GmbH 
Otto-Roehm-Strasse 69 
64293 Darmstadt 
Germany 

Phone: +49 (0)6151 8173-20 
Fax: +49 (0)6151 8173-29 

www.peak-system.com 
info@peak-system.com 

Document version 2.2.1 (2012-04-04) 

http://www.peak-system.com/�
mailto:info@peak-system.com�


PCAN-PC/104 – User Manual 
 

3 

Contents 

1 Introduction 5 
1.1 Properties at a Glance 5 
1.2 System Requirements 6 
1.3 Scope of Supply 7 

2 Installing and Configuring the Software and the 
Card 8 

2.1 Configuring the Card 8 
2.1.1 Interrupt 9 
2.1.2 I/O Address Range 10 

2.2 Installing the Software and the Card 12 
2.3 Modifying the Computer's BIOS Settings 13 

2.3.1 Indicating Used Interrupts 14 
2.3.2 Deactivating the APIC Mode 14 

3 Connecting the CAN Bus 16 
3.1 D-Sub Connector 16 
3.2 Supplying External Devices via the CAN 

Connector 18 
3.3 Cabling 20 

3.3.1 Termination 20 
3.3.2 Example of a Connection 20 
3.3.3 Maximum Bus Length 21 

4 Using the Software 22 
4.1 PCAN-View for Windows 22 

4.1.1 Receive/Transmit Tab 25 
4.1.2 Trace Tab 27 
4.1.3 Status Bar 28 

4.2 Linking Own Programs with PCAN-Basic 29 
4.2.1 Features of PCAN-Basic 30 



PCAN-PC/104 – User Manual 
 

4 

4.2.2 Principle Description of the API 31 
4.2.3 Notes about the License 32 

5 Technical Specifications 33 

Appendix A CE Certificate 35 

Appendix B Dimension Drawing 36 

Appendix C Quick Reference 37 
 



PCAN-PC/104 – User Manual 
 

5 

1 Introduction 

The PCAN-PC/104 is a compact PC/104 CAN card which allows the 
networking of one or two CAN busses to a PC/104 system. Device 
drivers and programming interfaces exist for different operating 
systems, so programs can easily access a connected CAN bus. 

Tip: At the end of this manual (Appendix C) you can find a 
Quick Reference with brief information about the installation 
and operation of the PCAN-PC/104 card. 

1.1 Properties at a Glance 

 Form factor PC/104 

 Multiple PC/104 cards can be operated in parallel (interrupt 
sharing) 

 14 port and 8 interrupt addresses are available for configuration 
using jumpers 

 1 or 2 High-speed CAN channels (ISO 11898-2) 

 Compliant with CAN specifications 2.0A (11-bit ID)  
and 2.0B (29-bit ID) 

 NXP CAN controller SJA1000, 16 MHz clock frequency 

 NXP CAN transceiver PCA82C251 

 CAN bus connection via D-Sub, 9-pin (in accordance with 
CiA® 102) 

 Bit rates up to 1 Mbit/s 

 Galvanic isolation up to 500 V for the CAN interface (only opto-
decoupled models), separate for each CAN channel 
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 5-Volt power supply at the CAN connector connectible by solder 
jumpers, e.g. for external bus converter 

 Extended operating temperature range of -40 to +85 °C (-40 to 
+185 °F) 

Note: This manual describes the use of the PCAN-PC/104 card 
with Windows. You can find device drivers for Linux and the 
corresponding application information on the provided CD in 
the directory branch Develop and on our website under 
www.peak-system.com/linux. 

1.2 System Requirements 

 PC/104 stack with ISA bus (according to the PC/104 specification) 

 Operating system Windows 7/Vista/XP (32-bit),  
or Windows CE 6.x (x86 and ARMv4 processor support),  
or Linux (32-bit) 

http://www.peak-system.com/linux�
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1.3 Scope of Supply 

 PCAN-PC/104 card 

 Slot bracket with D-Sub connector(s) for the CAN bus 
connection 

 Device drivers for Windows 7/Vista/XP (32-bit) and Linux (32-bit) 

 Device driver for Windows CE 6.x  
(x86 and ARMv4 processor support) 

 PCAN-View CAN monitor for Windows 

 PCAN-View CAN monitor for DOS 

 PCAN-Basic programming interface consisting of an interface 
DLL, examples, and header files for all common programming 
languages 

 Manual in PDF format 
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2 Installing and Configuring 
the Software and the Card 

This chapter covers the configuration, the software setup for the 
PCAN-PC/104 card under Windows, and the card installation in the 
computer. 

2.1 Configuring the Card 

Before installing the PCAN-PC/104 card into the computer you may 
need to configure it. For each CAN channel an interrupt (IRQ) and an 
I/O address range is set for operation in the computer. 

At delivery the PCAN-PC/104 card has the following default settings: 

CAN Channel IRQ I/O Address Range Comment 

1 10 300h – 31Fh  

2 5 320h – 33Fh Dual Channel model only 
 

Tip: If the given resources are not permanently allocated by 
other devices, you can skip the configuration and directly 
continue with the following manual section 2.2 on page 12. 

For a configuration differing from the default settings you need to 
set jumpers on the PCAN-PC/104 PCB according to the following 
explanations. 

Attention! Electrostatic discharge (ESD) can damage or destroy 
components on the PCAN-PC/104 card. Take precautions to 
avoid ESD when handling the card. 
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2.1.1 Interrupt 

An interrupt (IRQ) must be assigned to each CAN channel. This is 
done with a single jumper on jumper field JP1 for CAN channel 1 
and jumper field JP2 for CAN channel 2 (latter refers only to the 
Dual Channel model). The PCAN-PC/104 card supports the inter-
rupts 3, 4, 5, 7, 10, 11, 12, and 15. The default setting at delivery for 
CAN channel 1 is interrupt 10, for CAN channel 2 interrupt 5. 

 
Figure 1: Position of the jumper fields for setting the interrupts,  

JP1 for CAN channel 1 (lower jumper field),  
JP2 for CAN channel 2 (upper jumper field,  

Dual Channel model only) 

It is possible to share the same interrupt between two existing CAN 
channels. Therefore you can configure the same interrupt when 
using two PCAN-PC/104 cards in the same computer. 

Tip: We suggest to configure different interrupts as long as 
resources allow it and use interrupt sharing only if this is not 
the case. 



PCAN-PC/104 – User Manual 
 

10 

2.1.2 I/O Address Range 

Each CAN channel must be assigned to an unique I/O address range 
in the computer. An address space from 200h up to 39Fh and 3E0h 
to 3FFh (h = hexadecimal) is available. PCAN-PC/104 uses 32 addres-
ses beginning from the configured base address. The configuration 
is done on jumper field JP3 for CAN channel 1 and jumper field JP4 
for CAN channel 2 (latter refers only to the Dual Channel model). 
One or several jumpers are needed for each jumper field. 

 
Figure 2: Position of the jumper fields for setting the I/O base addresses,  

JP3 for CAN channel 1 (left jumper field),  
JP4 for CAN channel 2 (right jumper field, Dual Channel model only) 

The following table shows the possible settings. The X stands for a 
set jumper. The default settings at delivery for CAN channels 1 and 
2 are highlighted. 

Continued on the next page 
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Jumper field JP3/JP4 

A B C D E 
I/O address range 

X     200h – 21Fh 

X    X 220h – 23Fh 

X   X  240h – 25Fh 

X   X X 260h – 27Fh 

X  X   280h – 29Fh 

X  X  X 2A0h – 2BFh 

X  X X  2C0h – 2DFh 

X  X X X 2E0h – 2FFh 

X X    300h – 31Fh 

X X   X 320h – 33Fh 

X X  X  340h – 35Fh 

X X  X X 360h – 37Fh 

X X X   380h – 39Fh 

X X X X X 3E0h – 3FFh 
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2.2 Installing the Software and the Card 

Setup the driver before inserting the card. 

Do the following to install the driver: 

1. Windows XP only: Make sure that you are logged in as user 
with administrator privileges (not needed for normal use of 
the PCAN-PC/104 card later on). 

2. Insert the supplied CD into the appropriate drive of the 
computer. Usually a navigation program appears a few 
moments later. If not, start the file Intro.exe from the root 
directory of the CD. 

3. On the page English > Drivers activate the entry PCAN-ISA. 

4. Click on Install now. The setup program for the driver is 
executed. 

5. Follow the instructions of the program. 

Tip: If you do not want to install the CAN monitor PCAN-View 
for Windows onto the hard disk together with the driver, you 
have the option to start the program later directly from CD 
without prior installation. 

Do the following to install the PCAN-PC/104 card in the 
computer: 

Attention! Electrostatic discharge (ESD) can damage or destroy 
components on the PCAN-PC/104 card. Take precautions to 
avoid ESD when handling the card. 

Shut down the computer. 

6. Disconnect the computer from the power supply. 

7. Plug the PCAN-PC/104 card onto a PC/104 connector. For 
details refer to the documentation of the computer. 
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8. Interconnect the connector for each CAN channel on the 
PCAN-PC/104 card (see Figure 3) with the CAN connector of 
the slot bracket using the attached flat cable. 

 
Figure 3: Connectors for the flat cables to the CAN connectors,  

J3 for CAN channel one (lower position),  
J4 for CAN channel 2 (upper position, Dual Channel model only) 

9. Reconnect the power supply of the computer. 

Note: Before switching on the computer, please follow the pro-
cedure for modifying the computer's BIOS settings described in 
the following section. 

2.3 Modifying the Computer's BIOS Settings 

To ensure a flawless operation of the PCAN-PC/104 card it is neces-
sary that you adjust settings in the BIOS setup of the computer: 

 Indicate used interrupts 

 Deactivate the APIC mode 
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Note: Due to a diversity of existing BIOS setup versions for 
computers we cannot give detailed instructions here. Instead 
we indicate common setting names. 

In order to know how to start the computer's BIOS setup please 
consult the corresponding documentation. Usually you can enter 
the BIOS setup by pressing the Del or F2 key shortly after switching 
on the computer. 

2.3.1 Indicating Used Interrupts 

By indicating the interrupts that are set on the PCAN-PC/104 card, 
you avoid that the corresponding resources are automatically 
assigned to other devices and that this results in conflicts. 

In the BIOS setup itself you can often find the settings for the 
interrupts under a menu item containing the text “PnP”. For the 
interrupt(s) used by PCAN-PC/104 change the setting to “Reserved” 
or “Legacy ISA”. 

2.3.2 Deactivating the APIC Mode 

Note: Do not mix up APIC with ACPI. 

The APIC mode is a certain type of interrupt management in a 
computer. 

If the APIC mode is active in your computer, you must deactivate it 
so that the PCAN-PC/104 card can work properly with interrupts. 

Do the following to determine in Windows if the APIC mode is 
active: 

Open the Windows Device Manager. 

10. Select the menu entry View > Resources by type. 
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11. Open the branch of Interrupt request (IRQ). 

If entries with interrupt numbers greater than 15 are listed, 
the APIC mode is active and you must deactivate it. 

Do the following to deactivate the APIC mode: 

Important note: When you deactivate the APIC mode in the 
BIOS setup, it may happen that you must reinstall Windows 
afterwards, because it cannot start anymore due to the low-
level setting. 

Restart the computer and switch to the BIOS setup. 

12. Search for the APIC setting and deactivate it. 

13. Save the changes in the BIOS and quit the BIOS setup. 

14. If Windows doesn't start properly, reinstall it or perform a 
repair installation. 
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3 Connecting the CAN Bus 

3.1 D-Sub Connector 

A High-speed CAN bus (ISO 11898-2) is connected to the 9-pin 
D-Sub connector. The pin assignment corresponds to the 
specification CiA® 102. 

 
Figure 4: Pin assignment High-speed CAN  
(view onto connector of the slot bracket) 

With the pins 1 and 9 devices with low power consumption (e.g. an 
external bus converter) can be directly supplied via the CAN con-
nector. At delivery these pins are not assigned. You can find a 
detailed description about the activation in the following section 3.2. 
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The pin assignment between the D-Sub port and the 10-pin connec-
tor on the PCAN-PC/104 card is as follows: 

 
Figure 5: Numbering at the 10-pin connector 

Pin Assignment 
Assignment 

D-Sub 

1 +5 V (optional) 1 

2 GND 6 

3 CAN_L 2 

4 CAN_H 7 

5 GND 3 

6 not connected 8 

7 not connected 4 

8 +5 V (optional) 9 

9 not connected 5 

10 not connected  
 

Tip: You can connect a CAN bus with a different transmission 
standard via a bus converter. PEAK-System offers different bus 
converter modules (e.g. PCAN-TJA1054 for a Low-speed CAN 
bus according to ISO 11898-3). 
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3.2 Supplying External Devices via the CAN 
Connector 

You can route a 5-Volt supply to pin 1 and/or pin 9 of the CAN con-
nector (independently for each CAN connector on the Dual Channel 
model) by setting solder jumpers on the PCAN-PC/104 card. Thus 
devices with low power consumption (e.g. a bus converter) can be 
directly supplied via the CAN connector. 

When using this option the 5-Volt supply is connected to the power 
supply of the computer and is not fused separately. The opto-
decoupled models of the card contain an interconnected DC/DC 
converter. Therefore the current output is limited to about 50 mA. 

Proceed as follows to activate the 5-Volt supply: 

Attention! Electrostatic discharge (ESD) can damage or destroy 
components on the PCAN-PC/104 card. Take precautions to 
avoid ESD when handling the card. 

Set the solder jumpers on the PCAN-PC/104 card according to the 
desired settings. During this procedure take especially care not to 
produce unwanted short circuits on the card. 

Figure 6 shows the positions of the solder fields on the PCAN-
PC/104 card. The table below contains the possible settings. 
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Figure 6: Position of the solder jumper fields for the 5-Volt supply  

(JP5 lower position, JP6 upper position) 

5-Volt supply → None Pin 1 Pin 9 Pin 1 + Pin 9 

JP5 (CAN channel 1) / 
JP6 (CAN channel 2)     

 

Attention! Risk of short circuit! If the option described in this 
section is activated, you may only connect or disconnect CAN 
cables or peripheral systems (e.g. an external bus converter) to 
or from the PCAN-PC/104 card while the computer is de-
energized. 
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3.3 Cabling 

3.3.1 Termination 

A High-speed CAN bus (ISO 11898-2) must be terminated on both 
ends with 120 Ohms. Otherwise, there are interfering signal reflec-
tions and the transceivers of the connected CAN nodes (CAN inter-
face, control unit) will not work. 

The PCAN-PC/104 card does not have an internal termination. Use 
the adapter on a terminated CAN bus. 

3.3.2 Example of a Connection 

 
Figure 7: Simple CAN connection 

In this example, the PCAN-PC/104 card is connected with a control 
unit by a cable that is terminated at both ends. 
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3.3.3 Maximum Bus Length 

High-speed CAN networks may have bit rates of up to 1 Mbit/s, 
where all CAN nodes must be able to process messages simultane-
ously. The maximum bus length is primarily depending on the bit 
rate. 

The following table shows the maximum CAN bus length at diffe-
rent bit rates: 

Bit rate Bus length 

1 Mbit/s 40 m 

500 kbit/s 110 m 

250 kbit/s 240 m 

125 kbit/s 500 m 

50 kbit/s 1.3 km 

20 kbit/s 3.3 km 

10 kbit/s 6.6 km 

5 kbit/s 13.0 km 
 

The listed values have been calculated on the basis of an idealized 
system and can differ from reality. 
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4 Using the Software 

This chapter covers the provided software PCAN-View and the 
programming interface PCAN-Basic. 

4.1 PCAN-View for Windows 

PCAN-View for Windows is a simple CAN monitor for viewing, 
transmitting, and logging CAN messages. 

 
Figure 8: PCAN-View for Windows 

Do the following to start and initialize PCAN-View: 

1. If PCAN-View is already installed on the hard disk, open the 
Windows Start menu, go to Programs > PCAN-Hardware, 
and select the entry PCAN-View. 
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If you haven't installed PCAN-View together with the device 
driver, you can start the program directly from the supplied 
CD. In the navigation program (Intro.exe) go to English > 
Tools, and under PCAN-View for Windows select the link 
Start. 

The dialog box for selecting the CAN hardware and for 
setting the CAN parameters appears. 

 
Figure 9: Selection of the CAN specific hardware and parameters 

If there is no entry in the list Available CAN hardware (for example 
at the first program start), you need to add one: 

Run PCAN-View with administrator privileges (Windows XP: 
user login with corresponding privileges, Windows Vista 
and 7: via the context menu of PCAN-View's Start menu 
entry). 

2. Click on the Add button. 

The dialog box Add CAN hardware appears. 
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Figure 10: Selection of the hardware 

3. Select the connected hardware and the operating mode 
from the list Type of CAN hardware, in this case PEAK ISA-
CAN SJA. 

4. Enter the I/O Address and the Interrupt, as they are set on 
the PCAN-PC/104 card (see section 2.1 Configuring the Card 
on page 8). 

Default setting on the card at delivery: 

CAN 
Channel 

IRQ I/O Address Range Comment 

1 10 300h – 31Fh  

2 5 320h – 33Fh Dual Channel model only 
 

5. Confirm your input with OK. 

6. From the list Available CAN hardware select the CAN 
channel to be used. 

7. Select the Bit rate that is used by all nodes on the CAN bus. 

8. Under Filter settings you can limit the range of CAN IDs to 
be received, either for standard frames (11-bit IDs) or for 
extended frames (29-bit IDs). 

9. Finally confirm the settings in the dialog box with OK. The 
main window of PCAN-View appears (see Figure 11). 
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4.1.1 Receive/Transmit Tab 

 
Figure 11: Receive/Transmit tab 

The Receive/Transmit tab is the main element of PCAN-View. It 
contains two lists, one for received messages and one for the 
transmit messages. Representation of CAN data is in hexadecimal 
format. 

Do the following to transmit a CAN message with PCAN-View: 

Select the menu command Transmit > New Message 
(alternatively  or Ins). 

The dialog box New Transmit Message is shown. 
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Figure 12: Dialog box New transmit message 

10. Enter the ID and the data for the new CAN message. 

11. The field Cycle Time indicates if the message shall be 
transmitted manually or periodically. If you want to transmit 
the message periodically, you must enter a value greater 
than 0. For a manual-only transmission enter 0. 

12. Confirm the entries with OK. 

The created transmit message appears on the 
Receive/Transmit tab. 

13. You trigger selected transmit messages manually with the 
menu command Transmit > Send (alternatively Space bar). 
The manual transmission for CAN messages being 
transmitted periodically is carried out additionally. 

Tip: Using the menu command File > Save the current transmit 
messages can be saved to a list and loaded for reuse later on. 
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4.1.2 Trace Tab 

 
Figure 13: Trace tab 

On the Trace tab the data tracer of PCAN-View is used for logging 
the communication on a CAN bus. During this process the CAN 
messages are cached in the working memory of the PC. Afterwards 
they can be saved to a file. 

The tracer can be configured to run in linear or in ring buffer mode. 
In linear buffer mode the logging is stopped as soon as the buffer is 
filled completely. In ring buffer mode the oldest messages are 
overwritten by incoming ones. 
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4.1.3 Status Bar 

 
Figure 14: Display of the status bar 

The status bar shows information about the current CAN connec-
tion, about error counters (Overruns, QXmtFull), and shows error 
messages. 

You can find further information about the use of PCAN-View in the 
help which you can invoke in the program via the Help menu or 
with the F1 key. 
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4.2 Linking Own Programs with PCAN-Basic 

 
Figure 15: PCAN-Basic 

On the provided CD you can find files of the programming interface 
PCAN-Basic in the directory branch Develop. This API provides ba-
sic functions for linking own programs to CAN interfaces by PEAK-
System and can be used for the following operating systems: 

 Windows 7/Vista/XP (32/64-bit) 

 Windows CE 6.x (x86/ARMv4) 

The API is designed for cross-platform use. Therefore software pro-
jects can easily ported between platforms with low efforts. PEAK-
System has created examples for the following programming 
languages: C++, C#, C++/CLR, Visual Basic, Delphi, Python, and 
Java. 
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4.2.1 Features of PCAN-Basic 

 Supports Windows 7/Vista/XP (32/64-bit) and Windows CE 6.x 
operating system 

 Multiple PEAK-System applications and your own can be 
operated on a physical CAN channel at the same time 

 Use of a single DLL for all supported hardware types 

 Use of up to 8 channels for each hardware unit (depending on 
the PEAK CAN interface used) 

 Simple switching between channels of a PEAK CAN interface 

 Driver-internal buffering of 32,768 messages per CAN channel 

 Precision of time stamps on received messages up to 1 μs 
(depending on the PEAK CAN interface used) 

 Access to specific hardware parameters, such as listen-only 
mode 

 Notification of the application through Windows events when a 
message is received 

 Extended system for debugging operations 

 Multilingual debugging output 

 Output language depends on operating system 

 Debugging information can be defined individually 

An overview of the API functions is located in the header files. You 
can find detailed information about the PCAN-Basic API on the 
provided CD in the text and help files (file name extensions .txt 
and .chm). 
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4.2.2 Principle Description of the API 

The PCAN-Basic API is the interface between the user application 
and device driver. In Windows operating systems this is a DLL 
(Dynamic Link Library). 

The sequence of accessing the CAN interface is divided into three 
phases: 

1. Initialization 

2. Interaction 

3. Completion 

Initialization 

A CAN channel must be initialized before using it. This is done by 
the simple call of the function CAN_Initialize. Depending on the 
type of the CAN hardware, up to eight CAN channels can be opened 
at the same time. After a successful initialization the CAN channel is 
ready for communication with the CAN hardware and the CAN bus. 
No further configuration steps are required. 

Interaction 

For receiving and transmitting CAN messages the functions 
CAN_Read and CAN_Write are available. Additional settings can be 
made, e.g. setting up message filters to confine to specific CAN IDs 
or setting the CAN controller to listen-only mode. 

When receiving CAN messages, events are used for an automatic 
notification of an application (client). This offers the following 
advantages: 

 The application no longer needs to check for received messages 
periodically (no polling). 

 The response time at reception is reduced. 
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Completion 

To end the communication the function CAN_Uninitialize is 
called in order to release the reserved resources for the CAN chan-
nel, among others. In addition the CAN channel is marked as "Free" 
and is available to other applications. 

4.2.3 Notes about the License 

Device drivers, the interface DLL, and further files needed for linking 
are property of the PEAK-System Technik GmbH and may be used 
only in connection with a hardware component purchased from 
PEAK-System or one of its partners. If a CAN hardware component 
of third-party suppliers should be compatible to one of PEAK-
System, then you are not allowed to use or to pass on the driver 
software of PEAK-System. 

If a third-party supplier develops software based on the PCAN-Basic 
and problems occur during the use of this software, consult the 
software provider. 
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5 Technical Specifications 

Connectors  

PC/104 ISA bus with 8 MHz clock rate, 16 bit bus width 

CAN D-Sub (m), 9 pins 
Pin assignment according to specification CiA® 102 

 

CAN  

Specification ISO 11898-2, High-speed CAN 
2.0A (standard format) and 2.0B (extended format) 

Bit rates 5 kbit/s - 1 Mbit/s 

Controller NXP SJA1000 

Transceiver NXP PCA82C251 

Galvanic isolation PCAN-PC/104: none 
PCAN-PC/104 opto: up to 500 V, separate for each CAN 

channel 

Supplying external 
devices 

PCAN-PC/104: D-Sub pin 1/9; 5 V, max. 100 mA 
PCAN-PC/104 opto: D-Sub pin 1/9; 5 V, max. 50 mA 
Not assigned at delivery 

Termination none 
 

Power supply  

Supply voltage 5 V 

Current consumption PCAN-PC/104 Single Channel: max. 150 mA 
PCAN-PC/104 Dual Channel: max. 170 mA 
PCAN-PC/104 Single Channel opto: max. 210 mA 
PCAN-PC/104 Dual Channel opto: max. 270 mA 

 

Continued on the next page 
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Environment  

Operating temperature -40 - +85 °C (-40 - +185 °F) 

Temperature for storage 
and transport 

-40 - +125 °C (-40 - +257 °F) 

Relative humidity 15 - 90 %, not condensing 

EMC EN 55024:2003-10 
EN 55022:2008-05 
EC directive 2004/108/EG 

 

Measures  

Size 96 x 91 x 24 mm 
(see also dimension drawing Appendix B on page 36) 

Weight PCAN-PC/104 Single Channel: 57 g 
PCAN-PC/104 Dual Channel: 63 g 
PCAN-PC/104 Single Channel opto: 59 g 
PCAN-PC/104 Dual Channel opto: 65 g 
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Appendix A CE Certificate 
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Appendix B Dimension Drawing 

 
Figure 16: View PCAN-PC/104 

The figure does not show the actual size of the product. 
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Appendix C Quick Reference 

Default setting at delivery 

CAN Channel IRQ I/O Address Range Comment 

1 10 300h – 31Fh  

2 5 320h – 33Fh Dual Channel model only 
 

Software/Hardware Installation under Windows 

Before installing the PCAN-PC/104 card in the PC/104 stack, please 
setup the corresponding software package from the supplied CD 
(with administrator privileges). After switching on the computer 
enter the BIOS setup. In the PnP table mark the interrupts used by 
the PCAN-PC/104 card as reserved. 

Getting Started under Windows 

Run the CAN monitor PCAN-View from the Windows Start menu as 
a sample application for accessing the PCAN-PC/104 card. For 
initialization of the card, indicate the parameters (I/O base address, 
interrupt) and select the CAN connection and the CAN bit rate. 

CAN connector (D-Sub, 9-pin) 
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